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EasyHelp™ is an easy to use system that simplifies in the creation of Microsoft Help 
files and HTML files (for Web pages) from Microsoft Word documents. EasyHelp is 
ideal for user manuals and procedures, because the same document can be used to 
produce both the printed copy and the help file and a HTML file.

With EasyHelp non technical authors can now produce sophisticated hypertext 
systems without an in depth knowledge of the Microsoft Help Compiler or the HTML
tags.

Main Parts to this Manual

Quick Start
More about EasyHelp
Installing EasyHelp
Using EasyHelp

Topics Links Graphics
Shortcut keys

Configuring EasyHelp
The EasyHelp INI file

Frequently Asked Questions
Known Bugs and Limitations
Planned Enhancements
Tips
Terms for the novice
Important Legal Stuff
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New Features in this Version
This Version replaces EASY25x.ZIP and EASY26x.ZIP

· Context numbers now supported, automatically creates C header files

· Improved graphics handling, automatically replaces bitmaps with references to shg
files if they exist etc. Or for HTML replaces with GIF file references

· Better error trapping.

· Even easier to use.

· Improved deleting capabilities

· Improved installation and presentation

· Whole set of new example files to get you going quickly.

· Intelligent detection of topic type when creating links.

· Example a to z index and graphics included.

· Open interface to the Topic and Link macros, contact Eon solutions for details

· Colours are user definable.

· Auto word selection when creating links.

· Goto topic/link option.

· Non UK/US versions of Word are supported, contact Eon Solutions for details.

· Generally much better than before!
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Quick Start
If you are an experienced computer user you may want to get going quickly. If this is 
the case, at least read this page!

Installing EasyHelp
1 Run a:setup to install EasyHelp.

2 Run the tutorial document from the EasyHelp Program Manager group

Preparing to use EasyHelp

1 Load Microsoft Word.

2 Create a new document based on the EasyHelp template.

or Load an existing document and then attach the EasyHelp template to it.  

3 Quickly check that EasyHelp is configured correctly by clicking on the 
configure icon on the Word toolbar. (Or select Tools | © Configure EasyHelp 
from the menu) 

Using EasyHelp
1 Create some topics by positioning the cursor on the heading of each topic and 

clicking the topic icon on the EasyHelp toolbar (Or select Insert | © EasyHelp 
Topic from the menu)

2 Create some links (to the topic that you have defined) by highlighting the text 
that is to be used as the link and clicking the link icon on the EasyHelp toolbar 
(Or select Insert | © EasyHelp Link from the menu)

3 Your document is now 'marked up'. You must now process this 'mark-up' by 
clicking the process icon on the EasyHelp toolbar (Or select Tools | © Process 
Mark-up from the menu)

4 Finally build your help file by clicking on the build icon on the EasyHelp 
toolbar (or select Tools | © Build Help from the menu)

That's it! You have now created a Microsoft Help file by following four simple 
steps:

  1. Create Topics (Ctrl+Shift+T) 

  2. Create Links (Ctrl+Shift+L) 

  3. Process the 'mark-up' (Ctrl+Shift+P)

  4. Build the Help file (Ctrl+Shift+B) 
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More About EasyHelp
EasyHelp is a set of macros contained in a template called EASYHELP.DOT. These 
easy to use macros can be executed either from the toolbar or shortcut keys, and 
enable you to mark-up a document with topics and hypertext links and graphics. 
Other macros enable you to process the marked-up document, then build and view the
resultant help file directly from within Word.

Apart from the ease of use, EasyHelp allows you to maintain one document that can 
be printed out as a hard copy manual or can be viewed as a help/html file. No 
complicated footnotes or extra page breaks clutter the document. In fact the only 
formatting changes made to the document are coloured text, to let you see where the 
topics and hypertext links are!

Since the marked up documents are saved as RTF format, any file that you process 
with EasyHelp can be used together to produce a large help publication. Although this
can be done manually, by a constructing a help project file, the next version of 
EasyHelp will simplify this task.

Other help authoring systems do exist, and some of them are very good. However, 
EasyHelp was designed for ease of use rather than wide functionality. The rationale 
behind EasyHelp was to allow topics, links and graphics to be marked as easily as 
possible, and to be able to produce a help file without any prior knowledge of the 
Help Compiler.  

EasyHelp can be tailored to meet specific needs. Contact the author for more details. 
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Installing EasyHelp
Installing EasyHelp is easy, simply follow the steps listed below: 

1 Put the EasyHelp installation disk in Drive A:

2 Please start Microsoft Windows if it is not already running.

3 Run the setup program from Program Manager as follows:

· In Program Manager, choose Run from the File menu. Windows displays 
the Run dialog box.

· Type a:setup in the Command Line box.

· Choose the OK button.

· Follow the setup instructions on the screen.

4 After installing the EasyHelp files, the Setup program creates a EasyHelp 
program group containing icons for the tutorial document, the readme file and 
the on-line help. 

5 Follow the tutorial by double clicking on the tutorial icon in the EasyHelp 
program manager group.

Read the section entitled Details of the Installation Process if you wish to know 
more about the installation process.

Details of the Installation Process
If you are reading this on-line (as a help file) the chances are that you have already 
installed EasyHelp on your system. Even so it is useful to know what the installation 
process did. This will improve your understanding of the EasyHelp system and will 
be helpful if the installation failed for some reason.

· The default location for the EasyHelp system files is C:\EASYHELP. If you 
wish, you can change this default to any directory of your choice. The directory
will be created for you and is referred to as the EasyHelp directory.

· Below the EasyHelp directory other sub directories are created:

1 EasyHelp\EXAMPLES containing the EasyHelp Example documents and 
related files:

2 EasyHelp\WORD containing a backup copy of EasyHelp.dot the 
Microsoft Word template file.

3 EasyHelp\GRAPHICS containing sample graphics.

4 EasyHelp\HC containing a files to run the help compiler. Put your 
purchased copy of the help compiler here.

see Important Legal Stuff

· EasyHelp will create a Program Manager Group (called EasyHelp.grp by 
default) at installation time. This group simply gives access to the EasyHelp 
help file, the EasyHelp tutorial document and the readme file.
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· EasyHelp will install its own INI file (user settings file) called EasyHelp.ini in 
your Windows directory. Whist you can change this file with any editor, you 
are advised to make changes via the configuration dialogs in the EasyHelp 
template.

· The EasyHelp macros are all contained in the file called EasyHelp.dot. This 
file should be placed in the Microsoft Word template directory. The installation 
process will attempt to do this for you, but if this did not happen, copy the file 
from the EasyHelp\WORD sub directory to your template directory using File 
Manager.

Important Legal Stuff
For legal reasons the Microsoft Help Compiler cannot be supplied with EasyHelp. 
You are expected to purchase a copy of this yourself. 

Note: The Help Compiler is normally included with language products such as 
Visual Basic and C compilers from Borland and Microsoft. So check your 
hard disk - you may already have the required files.

Note: Please use version 3.10.505 (extended) or later of the Help Compiler. 
Upgrades to the latest version are readily available from the Microsoft forum 
on CompuServe.
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Using EasyHelp
The best way to get started with EasyHelp is to go through the tutorial document. If 
you have not already done this please take some time out to do so.

You can activate EasyHelp in two ways:

1 Create a new document based on the EasyHelp template.

2 Attach the EasyHelp template to an existing document.

If you are not sure how to either of the above  please refer to your Microsoft 
Word documentation.

When EasyHelp active, the EasyHelp toolbar will be added

Besides being able to use the toolbar, there are two other ways to use EasyHelp:

1 Use the menu. You will see that EasyHelp has added some menu items. It 
is easy to see which are the EasyHelp items: they all have a © symbol to 
the left.

2 Use the shortcut keys. All the EasyHelp shortcut keys begin with 
'Ctrl+Shift'

Preparing to Use EasyHelp
In order to use EasyHelp on new or existing document you will need to attach the 
EasyHelp template (called EasyHelp.dot) to your document. For new documents you 
will be prompted for the name of the template to use - simply choose EasyHelp from 
the list. For existing documents you will need to attach the EasyHelp template to your
document (use the File | Template... menu option).

Shortcut Keys
Ctrl+Shift+T Create or edit a topic

Ctrl+Shift+L Create or edit a link

Ctrl+Shift+C Configure EasyHelp

Ctrl+Shift+P Process document mark-up

Ctrl+Shift+B Build help file

Ctrl+Shift+D Delete EasyHelp mark-up

Ctrl+Shift+H View the on-line help for EasyHelp

Ctrl+Shift+R View the reults of your built help file

Ctrl+Shift+E View build errors

Ctrl+Shift+A Restore text to normal (black) colour
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Topics
A topic is a chunk of information that is displayed on the screen when viewed by 
Microsoft Help. If the chunk of information is larger than the screen, scroll bars will 
appear. The end of a topic is marked by the beginning of the next topic or the end of 
the document.

With the topic function you can mark a new topic or edit an existing one. If your text 
cursor is on an existing topic you will be able to edit the topic.

One more thing to remember about a topic is that there are two types:

1. A jump topic. This will be marked in a green colour in your document. A 
jump topic is the most common and can be thought of as a jump to another 
position in the help file.

2. A popup topic. This will be marked in a blue colour in your document. A 
popup topic is normally used to display a smaller amount of information, and 
is frequently used for definitions and glossary type items.

Links
A link is a branch to a topic. It is normally a word or phase in your document.

With the link function you can mark a new link or edit an existing one. If you have 
marked the text of an existing link you will be able to edit the link.

Like topics, there are two types of link:

1. A jump link. This will be marked in a dark red colour in your document. A 
jump link is the most common and can be thought of as a jumping to another 
position in the help file.

When viewed by Microsoft Help a jump link will be underlined with a 
continuous line.

2. A popup link. This will be marked in a dark yellow colour in your document.

When viewed by Microsoft Help a popup link will be underlined with a dotted
line.

Note
All the colours are user definable by changing settings in the EasyHelp.INI file. 
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Graphics

This is a picture of me. This graphic was inserted as a picture using normal 
Word facilities. It will show up the same in the built help file. It can be 
marked as a popup or jump link using the link function of EasyHelp. When 
inserting a picture in a word document, it is better to insert it as a linked file.

EasyHelp will allow you to use normal bitmaps in the document, and will 
automatically search for corresponding .shg files and use them in the help file 
if it finds them in your EasyHelp Graphics Path. This will enable the printed 
document with graphics to look exactly as the help file. (neat!)
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Configuring EasyHelp
EasyHelp can be configured from within Word. To bring up the main configuration 

dialog click on the  icon on the toolbar. 

Global Settings
Paths

Give the location of the EasyHelp system files and the Help Compiler. The name 
of the help compiler is specified here. 

Options
Impose formatting allows you to enforce a standard style to the topic headings. 
If you wish to control the format of the headings to topics, uncheck this option.

Use Document Name if you deselect this option the help file will be created with
the name of your project.

Other

Show Configuration allows you to always show the configuration dialog before 
processing the document or building the help file. You will probably want to 
uncheck this option as you become more experienced with using EasyHelp.

Generate HTML check this option if you want to produce HTML file for Web 
pages.

Edit Topic Details File
As you build more sophisticated help files this file is used to specify a more 
details about your help topics. For example a long description of your help topics
and keywords that can be used to search for those topics.

For example keywords are specified by separating keyword with a semi colon.

Projects
The project options allow you to work on different projects and have unique 
settings for each project. Two projects exist when you first install EasyHelp, 
default and tutorial.

Tip: The default project settings are used as the basis of any new projects that you 
create. Change the default settings to suit your needs.

Project Name
Give a name to your project. A name must be eight characters or less. Your help 
file will have this name.

Help Title

The title of your help file.

First Help Topic

The name of the help topic to be used as the contents page of your help file.

 Built Files Path
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This is where your built help file will be put

Processed Files Path

This is where your Topic Details File resides and your processed documents.

Graphics Path

This is where any graphics files that are used by your help files reside.
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The EasyHelp INI File
The EasyHelp.INI file is located in your Windows directory. This file defines your 
own personal settings for EasyHelp. In later versions of EasyHelp all the settings will 
be accessible via dialogs, however in this release of EasyHelp you will need to edit 
the file manually using the notepad editor that comes with Windows

[Projects]
ProjectList=default,examples
Current=examples

[Paths]
EasyHelpPath=c:\easyhelp
CompilerPath=c:\easyhelp\hc
CompilerName=hcp

[General Settings]
Verbose=no
UseDocName=yes
AutoDoc=no (yes for extra documentation)
ScreenUpdate=no
Language=uk  (uk or german or dutch)
OldFormat=no (yes for old graphic support)

[Colors]
JumpTopic=11
PopupTopic=9
InlineTopic=10
JumpLink=13
PopupLink=14

[Help Format]
Html=no
ImposeTopicFormat=no

[Html Format]
SplitTopics=no (yes will create separate file for each topic)
Tables=no (yes will try to format tables but will slow down processing)

[Registration]
Id=?

[German]  (You can add other sections for other versions of Word)
ParagraphMark=^a
ManualPageBreak=^m

[Dutch] 
ParagraphMark=^a
ManualPageBreak=^h
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[Project default]
HelpOutputPath=C:\EASYHELP\examples
HelpInputPath=C:\EASYHELP\examples
GraphicsPath=C:\EASYHELP\graphics
Contents=contents
HelpTitle=Help: My Help
WindowPosition=(46,53,922,913) (leave bl;ank will use the Windows defaults)
WindowColor=(255,255,246) (leave blank will use the Windows defaults)
TitleColor=(255,255,192) (leave blank will use the Windows defaults)

[Project examples]
HelpOutputPath=c:\easyhelp\examples
HelpInputPath=c:\easyhelp\examples
GraphicsPath=c:\easyhelp\graphics
Contents=contents
HelpTitle=EasyHelp Example
WindowPosition=(46,53,922,913)
WindowColor=(255,255,246)
TitleColor=(255,255,192)
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Processing your document
When your document is processed it is converted to an RTF file suitable for input into
the help compiler.

Building you help file
The build option will open a window to run the help compiler. Do not worry if there 
are errors displayed on the screen - these can be viewed at any time by pressing 
'Ctrl+Shift+E' or selecting from the help menu.

Deleting Mark-up
Mark-up can be deleted in a paragraph by positioning the text cursor anywhere in the 
paragraph and using the shortcut keys 'Ctrl+Shift+D', or by selecting '© Delete 
EasyHelp Mark-up' from the Edit menu or pressing the Delete button on the 
EasyHelp toolbar.
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Frequently Asked Questions
What to do if things are not working as expected?
Why are my paragraphs aligned unevenly?
There must be more to it.
How do you build a help file from multiple documents?

What to do if things are not working as expected?
First check the EasyHelp files are in the places you expect them to be in. Then check 
the configuration dialog points to the correct locations. Go back and load the example
documents and see if these can be processed and built as a help files.

Read through the on-line help file for EasyHelp to see if you can spot any problem 
areas.

Try reinstalling EasyHelp from the install disk.

Remember that computer programs are only human and contact me. I will do my best
to get you working again.

Uneven paragraphs
Normally hanging indents are prone to this. The reason is because the default tab 
stops have been used. Make sure you mark actual tabs on your ruler.

There must be more to it!
Well there is ... but not much more. Topics and links are the main concepts that you 
need to grasp. You will notice that any document can be marked up as a hypertext file
whilst leaving the document in its original form (except for colour changes!). This is 
exactly what EasyHelp was designed for: to save trees, by enabling manuals, 
procedure documents, in fact anything, to be produced in hypertext form.

The best way to learn more about EasyHelp is to work with it for a while. It will 
eventually become a normal part of your document processing process.

EasyHelp allows you to convert any Word document into a form that can be viewed 
as on-line help in Microsoft Windows. The way you do this is to 'mark-up' your 
document with topics and links.
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Making a help file from multiple documents
· Mark-up your documents. Check the formatting.

· Spend some time adding proper descriptions and key words to your mark-up 
details file. This can be done before you mark up your documents, if you know 
what how your are going to name your topics.

· Then process all your documents. 

· Then use the help project created by the build process as a guide and add in the 
file names of all your processed documents. The following is an example of a 
typical help project file (tutorial.hpj):
[OPTIONS]
root=c:\EasyHelp\examples
bmroot=c:\EasyHelp\examples
errorlog=c:\EasyHelp\examples\tutorial.err
title=EasyHelp Tutorial
contents=contents
[FILES]
tutorial.rtf
List your files here
One after the other
[WINDOWS]
main="EasyHelp Tutorial", (46,53,922,913 ),, (255,255,246), 
(255,255,192)
[CONFIG]
BrowseButtons()

· Then simply execute the help compiler from a DOS window with the help project 
name as a parameter. As in: HCP project_name.  
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Known Bugs and Limitations
Not so much bugs, but features that are known to work incorrectly. Most of these will
be fixed in the next release.

· Symbols do not show up in the help file.
Unfortunately this is a problem with the RTF format that Word generates. 
Little can be done about this, apart from using bitmaps for the symbols.

· The configuration dialogs allow invalid data.

Unfortunately Word only provides rudimentary features for dialogs. Extensive
validation of fields is difficult to say the least. I hope you can live with this 
one for a while. Validation will certainly be improved with version 3.0. Long-
term, the dialogs will be a proper Windows style dialogs (written in a 
compiled language)

· EasyHelp does not work with my version of Word.

Versions of Word before 6.0a do not work. Contact Microsoft for your free 
upgrade.

· I would like to see my graphics on the screen in Word and in my printed 
document.

You can do this by inserting a picture. It is better to use linked graphics as 
these will be supported fully in version 3.0 of EasyHelp. However if you wish 
to use pictures with hotspots you will need to make sure a SHG file exist in 
your graphics path.
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Planned Enhancements
If you like EasyHelp and find it useful please let me know. Version  3 is being 
developed as a fully compiled addin to Word and will be improved as follows:

· Faster and even easier to use

· Better dialogs and control over your settings

· Better support for help macros

· Multiple help window support

· More control over the formatted help file

· Better support for HTML generation
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Tips
Large documents or publications
Quickly restoring the text colour to black
Go through the EasyHelp example files!

Large Documents or Publications
It is better to use smaller documents and then merge them into a complete 
publication. This can easily be done by creating a MASTER document that includes 
the smaller documents. For example:

{include part1.doc}

{include part2.doc}

{include part3.doc}

The INCLUDE fields are special filed codes that instruct Word to insert into the 
document the item named in the code. See Chapter 11 or the Word manual for more 
details.

The following short macro will ensure that the master document is up to date. If you 
name this macro AutoOpen and save it with the template associated with the 
MASTER document, it will run automatically every time the MASTER document is 
opened.
Sub Main

ViewFieldCodes 1
StartOfDocument 0
EditFind .Find = "include", .WholeWord = 0,\

.MatchCase = 0,.Direction = 2, .Format = 0
While EditFindFound() = - 1
    UpdateFields
    EditFind .Find = "include",.WholeWord = 0,\

.MatchCase = 0,.Direction = 2,.Format = 0
Wend
StartOfDocument
Super FileSave
ViewFieldCodes 0

End Sub

Quickly restoring the text colour to normal
Mark the text, then press Ctrl+Shift+A or select the 'Normal Colour' menu item on 
the 'Format' menu.
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Terms for the Novice
Program Manager The front end program to Microsoft Windows.

Program Manager Group A menu, comprising of a group of icons, which can run 
programs when the icons are double clicked.

Double Clicking Clicking the mouse button (left normally) twice in quick
succession.

Icon Small graphic picture.

EasyHelp Template File
EasyHelp.dot is the Word template file. This should be put in the same place as all 
your other template files.

Help Project File
A file that lists the component files making up a help file and special formatting 
instructions. Refer to the documentation that came with your help compiler for more 
details.

Pictures with hotspots
These are called 'Segmented Hyper Graphic Files'. They can be created from bitmaps 
by using the shed editor included with the help compiler.

Popup Topics
Popup topics are marked with dark yellow colour in your document. In a help file, 
they look like this. When clicked they appear as a small window; they disappear on 
the next mouse click.

Popup topics are normally used for smaller pieces of information such as definitions.

Jump Topic
A jump topic is like this. It stays on the screen until you jump somewhere else.
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General Information

Support
EasyHelp was conceived and written by James Holroyd of Eon Solutions.

Please direct any queries, problems or suggestions to James Holroyd
at Eon Solutions.

Email: eon@cix.compulink.co.uk
Tel: 0973 209667

Version Information
EasyHelp is version 2.70, Feb 1995, with HTML option

Requires version 6.0a of Word or later

Requires version 3.10.505 (extended) of the Microsoft Help Compiler

A version for 2.0c of Word is available

James Holroyd

Eon Solutions (Software, Training and Consultancy)

12 Juniper Rise
Upton Priory 
Macclesfield
Cheshire
England
SK10 4XT

Email: eon@cix.compulink.co.uk
Tel: 0973 209667
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Details of the EasyHelp INI file
Colours of Topic and Links
If you want to use different colour for the mark-up change the settings in the ini file 
but remember you MUST use different colours for each statement.

1 Black
2 Blue
3 Cyan
4 Green
5 Magenta
6 Red
7 Yellow
8 White
9 Dark Blue
10 Dark Cyan
11 Dark Green
12 Dark Magenta
13 Dark Red
14 Dark Yellow
15 Dark Gray
16 Light Gray
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Registering EasyHelp
EasyHelp™ (2.xx) Registration Form

To:  Mr James Holroyd      
Eon Solutions        (Cheques/Money orders payable

     12 Juniper Rise                    to Eon Solutions)
     Upton Priory        
     Macclesfield         Credit/Debit cards also accepted
     Cheshire
     England     Tel: UK 0973 209667
     SK10 4XT             Email: eon@cix.compulink.co.uk

I WOULD LIKE TO REGISTER/ORDER THE FOLLOWING: 

Qty Product Exc VAT Inc VAT Total

EasyHelp personal use £25.00 £29.38

EasyHelp corporate £90.00 £105.75

EasyHelp corporate HTML plus £180.00 £211.50

Credits cards accepted: Visa, Eurocard, Access, Mastercard 

Debit cards accepted:   Visa Delta

IMPORTANT NOTES:

1. 'Personal' use gives you to Email/Tel support.

2. 'Corporate' use entitles you to additional priority support 

3. VAT is charged at the standard rate for orders from UK/EC countries. 

4. VAT is charged at zero rate for orders from NON UK/EC countries such as the 
US.

5. VAT is charged at zero rate for orders from the EC *only* if you supply your 
VAT registration number with this order.

6. On receipt of your payment you will be sent your registration number and a VAT 
receipt.

7.  If you have difficulty paying in UK Pounds pay by credit card
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PLEASE SUPPLY YOUR DETAILS
       Name: 

    Company: 

    Address: 

               

  

    Country: 

      Email: 

     VAT No: 

CREDIT/DEBIT CARD DETAILS
Type:

Number:

Expiry Date:

 Signature:

WHERE DID YOU FIND OUT ABOUT EASYHELP?

OTHER COMMENTS

EasyHelp Page 27 Version 2.5


	#LPJames# #TJContents#EasyHelp User Guide #LPVersion#Version #LPSupport#Support #LJNew#New #LJRegister#Register
	Main Parts to this Manual

	#TJNew#New Features in this Version
	#TJQuickStart#Quick Start
	#TJMore#More About EasyHelp
	#TJInstalling#Installing EasyHelp
	#TJInstallDetails#Details of the Installation Process
	#TPLegal#Important Legal Stuff
	#TJUsing#Using EasyHelp
	#TPPreparing#Preparing to Use EasyHelp
	#TPShortcutKeys#Shortcut Keys
	#TJTopic#Topics
	#TJLink#Links
	Note
	#TJGraphics#Graphics
	#TJConfiguring#Configuring EasyHelp
	Global Settings
	Edit Topic Details File
	Projects

	#TJEasyHelpIni#The EasyHelp INI File
	[Projects]
	[Paths]
	[General Settings]
	#LPIniColors#[Colors]
	[Help Format]
	[Html Format]
	[Registration]
	[German] (You can add other sections for other versions of Word)
	[Dutch]
	[Project default]
	[Project examples]

	#TPProcess#Processing your document
	#TPBuild#Building you help file
	#TPDeleting#Deleting Mark-up
	#TJFaq#Frequently Asked Questions
	#TPNotWorking#What to do if things are not working as expected?
	#TPUneven#Uneven paragraphs
	#TJMoreToit#There must be more to it!
	#TJMultiple#Making a help file from multiple documents

	#TJKnownBugs#Known Bugs and Limitations
	#TJPlannedEnhance#Planned Enhancements
	#TJTips#Tips
	#TJLargeDoc#Large Documents or Publications
	#TPMakeAuto#Quickly restoring the text colour to normal

	#TJTerms#Terms for the Novice
	#TPTemplate#EasyHelp Template File
	#TPHelpProject#Help Project File
	#TPShg#Pictures with hotspots
	#TPPopupTopics#Popup Topics
	#TJJumpTopics#Jump Topic

	#TPGeneral#General Information
	#TPSupport#Support
	#TPVersion#Version Information
	#TPJames#James Holroyd

	#TPIniDetails#Details of the EasyHelp INI file
	#TPIniColors#Colours of Topic and Links

	#TJRegister#Registering EasyHelp

